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1. Lwu y quan trong

S6 tay st dung dién t& nay danh cho moi
nguw®i dung str dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay truéc khi st dung man hinh. Sé tay
bao gébm nhirng théng tin va cac lvu y
quan trong lién quan dén viéc sir dung
man hinh.

Ché dd bao hanh cta Philips ap dung voi
diéu kién la san pham phai dwoc st dung
dung cach theo muc dich st dung, theo
cac hwdng dan hoat ddng cung vai viéc
xuét trinh héa don gbc hoéac bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mAu ma va ma sb san xuét cta san pham.

1.1 Lwu y an toan va bao dwéng

) canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu ré trong tai liéu nay cé thé
khién nguoi dung dé bi dién giat, gap cac
rdi ro vé dién va/hodc co hoc.

Hay doc va thwe hién theo cac hwéng dan
sau khi két ndi va str dung man hinh may
tinh:

Hoat dong ]

* Khdéng dat man hinh dwéi anh nang
trl_yc‘tiép va tranh xa [0 sw&i hoac moi
nguon nhiét khac.

« Di chuy&n moi db vat co thé roi vao
céc 16 théng gié clia man hinh hoac
ngan can qyé trinh lam mat thich hgp
cua cac thiét bi dién t&r bén trong man
hinh.

« Khéng bit kin cac 16 thédng gi6 trén vé
man hinh.

»  Dam béo d&t man hinh & gan noi co
phich cam va 6 cam dién.

» Néu tat man hinh bang cach rat cap
nguon hoac déy’dién DC, héy doi 6
giay trwdc khi cam cap ngudn hoac

day dién DC dé& man hinh hoat déng
binh thwdng.

Hay luén dung cap ngudn chuan duoc
cap bé&i Philips. Néu thieu cap nguon,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tdm théng tin ti€u dung
cham so6c khach hang)

Khéng dat man hinh & noi bi chan
déng hay va cham manh khi dang
hoat déng.

Khéng dap hoac lam roi man hinh khi
dang hoat dong hodc khi di chuyén.

Bao dwéng

DPé& man hinh khéng bi hdng, khéng dé
nén qua manh |én mat man hinh LCD.
Khi di chuyén man hinh, hay ndm chat
khung man hinh dé& nhéc 1én; khéng

nh&c man hinh bang cach dat ban tay
hoac ngoén tay Ién mat man hinh LCD.

Rut phich cdm man hinh néu ban khéng
dinh st dung né trong thoi gian dai.
Rut phich cdm man hinh néu ban can
lau chui man hinh bang mét miéng
vai hoi wét. Ban co thé lau man hinh
bang vai kho khi da ngat dién. Tuy
nhién, drng bao gid dung dung mai
hiru co, chdng han nhw cdn hodc cac
chét 1dng cé ngudn gbc tlr amoniac dé
lau man hinh.

Dé tranh nguy co bij dién giat hoac
héng vinh vién bd man hinh, khdng
dat man hinh & noi c6 bui, mwa, nwéc
hodc & noi qua am wét.

Néu man hinh bj wét, hay lau né bang
vai kho cang sém cang tét.

Néu chéat la hodc nwéc dinh vao man
hinh, hay ngéat dién ngay va rut cap
nguén. Sau dé lau sach chét la hoac
nwdc rdi glri man hinh dén trung tam
bao dudng.

Khéng cét gitr hodc s& dung man hinh
& noi c6 ngudn nhiét, anh nang truc
tiép hodc qua lanh.



« Dé& duy tri hoat ddng tdi wu ctia man
hinh va s&r dung né trong thi gian dai,
hay dung man hinh & noi ndm trong
gi¢i han nhiét dd va dd 4m sau.

« Nhiét dé: 0-40°C 32-95°F
« D6 am: 20-80% RH

« LUWU Y: Ludn bat trinh bao vé man
hinh chuyén déng khi ban khéng st
dung man hinh. Luén bat &vxng dung
lam md&i man hinh dinh ky, néu khéng,
man hinh cta ban sé& hién thi nhirng
ndi dung tinh khéng thay dbi. Hién thi
lién tuc cac anh tinh trong mét thoi
gian dai c6 thé gay ra hién twong “anh
thtr ndng”, con dwoc goi la “anh ao”
hay “anh bong ma”, trén man hinh cua
ban.

“Anh thir néng”, “Anh d0” hay “Anh
béng ma” 1a hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thtr ndbng” hoac “anh ao” hay “anh
bong ma” sé dan dan bién mét sau
mét thdi gian man hinh bi ngét dién.

2 canh bao

Cac hién twong “anh thtr ndng” hay “anh
40” hay “anh bong ma” sé& khéng biét méat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng ndm trong chinh séach
bao hanh cua chung téi.

Dich vu

« Chinhan vién dich vu chuyén mén
ma&i dwgc m& vo boc man hinh.

« Néu can moi tai liéu hwéng dan dé
stra chira hoac tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (vui long tham khao
chwong “Trung tdm thong tin tiéu
dung”)

« Dé biét thong tin vé viéc van chuyén,
vui ldng tham kh&o muc “Théng sb k§
thuat”.

* Khoéng dat man hinh trong xe hoi/cop
xe dwdi anh nang tryec tiép.

& Ghi chu

Hay tham khao y kién cua ky thuat vién
dich vu néu man hinh khéng hoat déng
binh thwdng hodc néu ban khéng chéc
phai thwc hién quy trinh nao khi da lam
theo cac hwdng dan hoat ddng néu trong
sb tay nay.

1.2 M6 ta biéu twong

Cac muc phu sau day mo ta cac quy wéc
vé bieu twgng dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan b sb tay nay, cac doan chi
c6 thé di kém biéu twong va duoc in dam
hodc in nghiéng. Cac doan nay bao gém
cac ghi chu, lwu y hoac canh bao. Chang
dwoc str dung nhw sau:

& Ghi chu

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét gitp ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac théng tin giup
ban biét cach tranh dwoc sw ¢ hdng hoc
tiém an dbi véi phan clrng hodc mét div
liéu.

@ canh bao

Biéu twong nay cho biét sw tbn thwong
co thé tiém an va gitp ban biét cach tranh
dwoc sw cb do.

Mot sé canh bao co thé xuat hién & nhiéu
dinh dang va cé thé khéng di kém mot
biéu twong. Trong nhirng trwéng hop nay,
cach thire trinh bay cu thé cda canh bao
doé dwoc quy dinh béi co quan chirc nang
lién quan.



1.3 Virt bo san pham va vat liéu
dong goi

Thiét bj dién & dién t& bj virt b6-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used
electrical and electronic appliances,

this product may not be disposed of

with normal household waste. You are
responsible for disposal of this equipment
through a designated waste electrical

and electronic equipment collection. To
determine the locations for dropping off
such waste electrical and electronic,
contact your local government office, the
waste disposal organization that serves
your household or the store at which you
purchased the product.

Your new monitor contains materials that
can be recycled and reused. Specialized
companies can recycle your product to
increase the amount of reusable materials
and to minimize the amount to be
disposed of.

All redundant packing material has been
omitted. We have done our utmost to
make the packaging easily separable into
mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high
quality materials and components which
can be recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.




2. Cai dat man hinh

2.1 Lap dat

El Nbi dung g6i hang

VGA (tuy chon) DVI (tuy chon)

B Lip chan dé

1.

DPat man hinh ndm sip trén bé mét
mém min, can than dé tranh lam tray
xwédc hoac hdng man hinh.

Gitr chan dé man hinh bang ca hai tay
va lap chat chan dé vao tru gde.

(1) G&n nhe chan dé vao tru dé cho
dén khi chét cai khdp chat vao
chan de.

(2) Dung ngén tay van chat dinh vit
nam & phia dwdi chan de va siet
chat chan dé vao tru deé.




El Kétndivéi PC
Mau 227E3L:

PHILIPS

o0
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© Diu vao ngudn dien AC
O biu vao VGA
© bau vao DVI-D
Khoa chéng trém Kensington
MAau 227E3LH:
000 0
==
]
o

© bAau vao ngudn dien AC
O piuvao VGA
O biuvao DVI-D
O biu vao HDMI
DPau vao am thanh
DPau ra am thanh
Khoa chéng trdom Kensington

Mau 227E3LPH:

PHILIPS

O Diu vao ngudn dien AC
O Dbiu vao VGA

© piuvaoDVI-D

O biu vao HDMI

© biu ra am thanh HDMI

Khoa chéng trém Kensington

Két néi véi PC

1.

Cam chat cap ngudn vao mét sau cla
man hinh.

T4t may tinh va rat cap ngudn.

Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

Cam cap ngudn clia may tinh va cap
ngudn cda man hinh vao 6 cam dién
gan do.

Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.



2.2 Str dung man hinh

f i rr\
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El M6 ta mat trwdc chia san pham
MAau 227E3L:

Mau 227E3LH:
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/v ©/A 10/< /0K 0)
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0 B‘AT va TAT ngudén man
hinh.

&) /0K |Truy nhdp menu OSD.

4 |Trd vé mic OSD trwéec.

Chinh am Iwvong loa.

A V¥V Chinh menu OSD.

/v ©/A /<4 B/0K )

| | [\ |
7 06 O e o (1

®©@ 0000 ©

© |bbi nguén vao tin hiéu.

Smartlmage Lite. C6 ba
& ché d6 dé ban lwa chon:

Standard (Chuén), Internet
va Game.

0 B‘AT va TAT nguén man
hinh.

&)/OK|Truy nhap menu OSD.

4 |Tré vé mirc OSD trudec.

O |Chuyén sang man hinh 4:3.

A V¥V Chinh menu OSD.

© |Pbi nguén vao tin hiéu.

Mau 227E3LPH:

Smartimage Lite. C6 ba
@ @ ché do dé ban lwa chon:

Standard (Chuén), Internet
va Game.

(5)

/v ©/A SENSOR/ < &/0K O]
| | [\ | |
(7] (6] © 0 (2) (1]

BAT va TAT nguén man
| .

O O |ym.

© & /O0K|Truy nhap menu OSD.

© A |Tré vé mirc OSD trude.
Cai mirc cam bién dé diéu

O | SENSOR khién dén nén ty dong.

© A V¥V [Chinh menu OSD.

O ©® |bdingudn vao tin hiéu.
Smartimage Lite. C6 ba
ché d6 dé ban lwa chon:

o @ Standard (Chuén), Internet
va Game.




. Cai dat man hinh
E1 M6 ta menu Hién thi trén man hinh

Hién thj trén man hinh (OSD) la gi?
Hién thj trén man hinh (OSD) la mét tinh
nang cé & moi man hinh LCD cua Philips.
N6 cho phép ngwdi dung diéu chinh hoat
ddng cua man hinh hoac chon cac chirc
nang cGia man hinh truc tiép théng qua
mot ctra sd hwéng dan hién thi trén man
hinh. M6t giao dién hién thj trén man hinh
dé st dung duwoc thé hién nhu sau:

Mau 227E3L:

) v
D -

b ' Language

] 0D Settings

v

M3u 227E3LH:

T—_— VGA ’
npu -
S DVI .

Color

Language

Audid

Color

v

Hwéng dan co ban va don gian vé cac
nut diéu khién

Trong menu OSD minh hoa & trén, ban cé
thé nhan ¥ A cac nat & g& mat trwdc cla
man hinh dé di chuyén con tré va nhan
nut OK dé xac nhan lya chon ho&c thay
dbi.

Menu OSD

Dwéi day la tbng quan vé co ciu cua
menu Hién thi trén man hinh. Ban co thé
st dung co’ cau nay lam thoéng tin tham
khao khi muén thwe hién cac diéu chinh
khac sau nay.

Main menu Sub menu
Power Sensor I: On — 0~4
Off
(available for selective models)

— VGA
Input

[ DVI (available for selective models)

L— HDMI (available for selective models)

— Picture Format — Wide Screen, 4:3
Picture

— Brightness — 0~100

— Contrast — 0~100

| SmartResponse __ Off, Fast, Faster, Fastest

P (available for selective models)

L— SmartContrast —— On, Off

—— Volume — 0~100 (available for selective models)
Audio

— Stand Alone — On, Off

— Mute — On, Off

r— Color Temperature — 6500K, 9300K
Color

— sRGB

— User Define Red: 0~100

E Green: 0~100
Blue: 0~100

Language — English , Espariol, Frangais, Deutsch, Italiano,

Portugués, Pycckui, fEIRRAR3Z, Turkge

OSD Settings — Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time out — 5,10, 20, 30, 60
Setup — Auto
— Power LED — 0,1,2,3,4
— Over Scan —— On, Off (available for selective models)
[ H. Position — 0~100
— V. Position — 0~100
[ Phase — 0~100
— Clock — 0~100
I Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Thong bao vé dd phan giai

Man hinh nay dwoc thiét ké dé hoat déng
t6i wu véi d6 phan giai goc la 1920 x 1080
@ 60 Hz. Khi dwgoc chinh sang dé phan
gidi khac, man hinh sé hién thj mot théng
bao: Dung 1920 x 1080 @ 60 Hz dé dat
két qua tét nhét.

Ban c6 thé tat théng bao hién thj do6 phan
giai goc tir muc Setup (Cai dat) trong
menu OSD (Hién thj trén man hinh).

El Tinh nang vat ly
Nghiéng

2.3 Thao dé va chan dé

El Thao chan dé

Trwdc khi bat dau thao chan dé man

hinh, hay thwc hién theo cac hwdng dan

bén dwdi dé tranh moi thiét hai hay chan

thwong co thé xay ra.

1. Dat man hinh ndm sép trén bé mat
min, can than dé tranh lam tray xwdc
hodac hdng man hinh.

2. Thao chan dé ra khéi tru dé bang

cach:

(1) Dung ngén tay néi léng dinh vit
nam & phia dw®i chan de.

(2) Chuyén nhe I&n xudng dé nha chot
cai khéa chan dé va kéo chan dé
ra khdi try dé.




Bl Thao dé

Ban c6 thé st dung tua vit dau det dé
an vao hai khép nha trén nép ban 1&
va cay nhe n3p ban I& dé thao né ra.

—_—

2. Thao 4 dinh vit rdi thao chan dé ra
khdi man hinh.




3. T6i wu héa hinh anh

3.1 Smartimage Lite

Kl Polagi?

Smartimage Lite cung cap cac chirc ndng
cai d&t sdn giup ban té6i wu héa man hinh
dé s&r dung cho cac kiéu ndi dung khac
nhau, linh hoat chinh d6 sang, dé twong
phan, mau séc va do sac nét khi sir dung
thwe té. Du lam viéc véi cac tng dung
bang cht¥, hién thi hinh anh hay xem
video, Philips Smartlmage Lite cling mang
lai cho ban hiéu qua man hinh téi wu nhét.
Bl Sao t6i phai can né?

Ban mudn mdt man hinh hién thi téi wu
moi kiéu ndi dung wa thich, phan mém
Smartimage Lite sé linh hoat chinh d6
sang, do twong phan, mau sac va do sac
nét khi st dung thwe t& nham nang cao
trai nghiém xem man hinh cua ban.

El cach hoat dong?

Smartlmage Lite 14 cdng nghé doc quyén
tién tién caa Philips vén sé phan tich cac
ndi dung hién thj trém man hinh cuta ban.
Dwa trén bdi canh s&r dung ma ban lya
chon, Smartlmage Lite sé linh hoat cai tién
doé twong phan, bdo héa mau sac va do
s&c nét ctia hinh anh dé cai thién néi dung
dang hién thj - tAt ca khi s dung thuc té
chi v&i duy nhat mét ci nhan nut.

B} Cach bat chirc ning Smartimage Lite?

(— N\

%

\ PHILIPS e )

L

1. Nhan BED @& khéi dong Smartimage
Lite trén man hinh;

2. Tiép tuc nhan BD dé chuyén gitra
Standard (Chuén), Internet, Game.

10

3. Menu OSD Smartimage Lite sé van
hién thi trén man hinh trong 5 giay
ho&c ban ciing c6 thé nhan OK dé xac
nhan Iwa chon.

4. Khi Smartlmage Lite & dwoc bat, bb
cuc sRGB sé ty dong tat. Pé dung
sRGB, ban phai t4t Smartimage Lite
bang nut B? & g& mat trwéc ctia man
hinh.

Néu khéng dung nat B dé cudn xudng,
ban ciing c6 thé nhan cac nut ¥ A dé chon
va nhan nat OK dé xac nhan lwa chon va
dong menu OSD Smartlmage Lite.

Co6 ba ché do dé ban Iwa chon: Standard
(Chuén), Internet va Game.

@ Smartlmage 1

Standard

Internet

« Standard (Chuan): Lam rd chir va
gidm dé sang giup ban dé doc chir va
b&t méi mat. Ché do nay tang dang ké
sw rd rang cua ndi dung chir va hiéu
suéat khi ban lam viéc v&i cac bang
tinh, file PDF, cac bai muc scan hoac
cac wng dung van phong khac ndi
chung.

 Internet: C4u hinh nay két hop bao
hda mau séc, linh hoat tdng dé twong
phan va sac nét dé hién thi anh chup
va cac hinh anh khac v&i do rd ndi bat
cung mau sac sbéng dong - tat ca moi
thr ma khéng hé c6 dau vét ciia mau
sac nhat va gia tao.

e Game: Tang mach truyén déng dé co
thdi gian dap &ng téi wu, gidm cac
bd & gai goc cho cac dbi twong di
chuyén nhanh trén man hinh, tdng do
twong phan cho b cuc sang va téi,
céu hinh nay mang lai cho ngudi choi
trai nghiém choi game tét nhat.



3.2 b6 twong phan théng minh
Kl Do lagi?

Cdng nghé déc dao vén linh hoat phan
tich ndi dung hién thj va tw dong téi wu
héa ty I1é twong phan cia man hinh LCD
dé mang lai d6 ré nét va trai nghiém xem
tdi wu, tdng mdrc d&n nén dé hién thi
nhirng hinh &nh sang ré hon, sac nét hon
va sbng dong hon hay gidm mirc dén nén
dé hién thj ré hinh anh trén phéng nén téi.
Bl Sao toi phai can n6?

Ban muén hién thj ndi dung rd nét cuing
cam giac thoai mai nhat khi xem moi loai
n6i dung. SmartContrast sé linh hoat chinh
do twong phan va mrc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe rd, sdng dong va sac nét hay hién thi
ndi dung chir ré rang dé doc cho céac tng
dung van phong. Bang cach gidm viéc tiéu
thu dién cGia man hinh, ban sé tiét kiém
dwoc chi phi ndng lwong va kéo dai tubi
tho cho man hinh cta ban.

El cach hoat dong?

Khi ban bat ché dd SmartContrast, n6 sé
phan tich ndi dung dang hién thj trong
thwc té dé chinh mau sac va mat do dén
nén. Chlrc ndng nay sé linh hoat tang
do twong phan dé mang lai cho ban trai
nghiém giai tri tuyét voi khi xem video
hoac choi game.

3.3 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i clia
Phillips cho phép ban diéu khién man hinh
qua giao dién dé hoa &o tién dung. Cac
diéu chinh phtrc tap Ia nhivng gi thudc

vé qua khr vi phan mém than thién voi
ngwdi dung nay sé hwdng dan ban qua
viéc tuy chinh dé phan giai, hiéu chinh
mau, diéu chinh ddng hé/géc pha, diéu
chinh diém trang RGB (Dé-Luc-Lam), v.v

Trang bi cdng nghé mai nhét vé thuat toan
16i Xt ly va phan trng nhanh, phdn mém
chay bang anh déng bat mat thwong thich
vé&i Windows 7 nay sdn sang nang cao trai
nghiém cua ban v&i man hinh Philips!

1

Kl cai gat

« Thuc hién theo chi dan va hoan tat quy
trinh cai dat.

« Ban c6 thé khéi dong phan mém sau
khi hoan tat cai dat.

« Néu mubn khéi déng sau, ban co thé
click phim tat phdn mém trén man hinh
nén ho&c thanh cdng cu may tinh.

PHILIPS

W|zard (Thuat si) khéi dong Ian dau
Lan dau khi cai dat phan mém
SmartControl Lite, n6 sé tw ddng vao
Wizard (Thuat si) khéi dong lan dau.

« Thuat si nay s& huwéng dan ban théng
qua viéc diéu chinh tirng buwdc vé hiéu
suat man hinh.

« Sau nay ban ciing c6 thé vao menu
Plug-in (B4 sung) dé bat thuat sf.

« Ban cé thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.

SmartControl Lite PHILIPS

Wizard
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=
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n Khé’i d@ng béng giao dién Chuén: B smartcontrol 2 - Philips 22581 (C530715000001) (i %

. N . SmartControl Lite PHILIPS
Menu Adjust (Pieu chinh):
. DN > s Focus
* Menu Adjust (Biéu chinh) cho phép

2 . ~ s the video signal.
ban chinh Brightness (B¢ sang), DU
U Pitch: Try to make the vertical bands disappear.
~ L. . , N Phase: Adjust to the brightest setting to minimize
(Trong tam), Position (Vi tri) va 2
Brightnass

Contrast (D6 twong phan), Focus
Adjust " movement on the screen.
Resolution (B6 phan giai). D >

+ g

« Ban c6 thé lam theo chi dan va thuc 2R .
hlén dIéU Chinh. N SRS Phase . 17

€

~ > ~ > N < Postion
» Lénh Cancel (Huy) sé héi ngwdi dung
, X > - K \ N % ?F
xem ho c6 mudn huy tién trinh cai dat Resdlutan
hay khéng \Q
Help
" {8 SmartControl 2 - philips 22581 (€530715000001) | 7)(X)
SmartControl Lite PHILIPS
Brightness {8 SmartControl 2 - philips 22581 (Cs30715000001) {F1(X
Improperly adjusted Brightness wil result in 2 loss of
detail in darker image areas. Adjust the Brightness for ;
the best possible picture qualty. Sma rtControI the pH I ll PS
1. Lower the Brightness to the minimum level.
2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve Position
an equal separation of the stripes.
. i Use the Position buttons to center the image on
Adiust §4 e iry., Uskiir ik Yook Sous G poation: Hhakrais
E ;h—tn up, down, left, or right.
rightness
= . 1. Use the Up/Down buttons to center the image
3 verticaly.
2. Use the Left/Right buttons to center the image
horzontaly.
Color Adjust
ey Brightness 100 . ; Brightness
' ¥ = = -
@ Position \g Contrast
Options FF ndo Reset, Color A
~
Resolution £ Focus
— o2
i = ¢
Help Opttre ps Undo Reset
!.! Resolution
Help
B smartControl 2 - Philps 22581 (C530715000001) (71X,
SmartControl Lite PHILIPS
Contrast @ SmartContral 2 - Philps 22581 (€530715000001) [#]| X

Adjust the Contrast (use the sider) to keep detais in
lighter image areas.

1. Raise the Contrast unti the numbers 1 and 2 SmartControl Lite PHILIPS

are no longer visble.
2. Showly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1

should remain barely visble. Resolution

]

Adjust You are currently at a Preferred resolution. For your
) display to show crisp, clear text, colors, and images,

your display should be set to its Preferred resolution.

Brightness
If your display is at 2 Non-Preferred resolution, cick
m on the Preferred button to change your resolution to
y Preferred.
Contrast

0

Color =~ Adiust y I™ Enable Resolution Notifier
+ Focus Contrast Brightness Picture Format

7 4:3 aspect ratio

Position

Options pF

Resolution Focus

Help Options g Preferred

! ! - HH“““““N""‘H““““““HH“““
: ‘||||||||||||||||||||||||||||||||||

1%

Undo Reset o

y
o
-
&
g
]
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Menu Color (Mau):

B smartControl

SmartControl Lite

R

W smartControl

SmartControl Lite

Color Whge Paint

Menu Color (Mau) cho phép ban chinh

mau RGB (Dé-Luc-Lam), Black Level
(D6 tbi), White Point (Diém trang),
Color Calibration (Hiéu chinh mau) va
Smartlmage Lite (Vui long tham khao
muc Smartimage Lite).

Ban c6 thé lam theo chi dan va thuyc
hién diéu chinh.

Tham théo bang bén dudi dé hinh
dung co ban vé muc menu phu trén
théng tin nhap cda ban.

Vi du Color Calibration (Hiéu chinh
mau sac):
2 - Phiips 225B1 (€530715000001) {7}iX)

PHILIPS

Black Level

Improperly adjusted Black Level wil result in 2 loss of
detall in darker image areas. Adjust the Black Level for
the best possble picture quality.

1. Adiust the black level of the Red, Green, and
Blue using the slider bars.

m

RGB
i Red 50
Black Level - i

White Point = O &)

Display Gamma

1
g Undo Reset

Options Calbration

ap

SmartImage

®

Help

2 - Philps 22581 (C530715000001)  {¥}(%
PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intensity create
white. This effects the overal color quality. For the
most accurate colors diick the Reset button then
select the White Point.
1. Please select the White Point value for the best
IM possile color quality.

Adjust RGB

il

Black Level

g White Point 6500K

5 =S
@ Display Garmima = Q +
|
. Undo Reset
Options Calibration
i
I
4|
Smartimage

®

Help

13

W SenntContinl 2-pl 7.

hilps 22581 (0530715000001 1 x

PHILIPS

SmartControl Lite

w

Adjust RGR
\g Dlack Lave
Color .,._,go_,._ Display Gamma 22
= 3
g Y -
\- Display Gamma.
. -
undo Rase!
Cpbions Galbration
ap
\ Srrurtbruge
Hedp
B smartControl 2 - philps 22581 (C530715000001) [T (%

SmartControl Lite PHILIPS

Calibration

Your o

2. Press Show

calibration &

Optons Calbration
ap
\ Smartimage
Help
how Me tart
Quick View

“Show Me” (Cho téi xem) sé bat
hwéng dan hiéu chinh mau.

Start (Bat dau) - bat dau quy trinh
canh chinh mau qua 6 budéc.

Quick View (Xem nhanh) tai cac hinh
anh trwéc/sau.

Tré vé giao dién chinh Color (Mau),
click nat Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khéng dwoc phép hiéu chinh mau va
tat cac nut khéi déng va xem nhanh.
Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.



z
< 4 Ay >

Man hinh hiéu chinh mau dau tién:

« Nut Previous (Trwéc) sé tat cho dén
khi man hinh mau th& hai bat Ién.

* Next (Ké tiép) s& chuyén vao muc tiéu
tiep theo (6 muc tiéu).

«  Cubdi cung, vao giao dién File>Presets
(File>Cai san).

*  Nut Cancel (Huy) s€ dong giao dién
ngwoi dung (Ul) va tré ve trang bo
sung.

Smartlmage Lite

Cho phép nguoi dung thay dbi cai dat dé
dat merc cai d3t man hinh t6t hon dwa vao
ndi dung.

Khi da cai dat Entertainment (Giai tri), tinh
nang SmartContrast va SmartResponse
sé tat.

" 8 SmartControl X

SmartControl Lite PHILIPS
SmartImage
SmartImage provides different brightness and
con odate today's wide range of
- 0st comfortable or
efficient when viewing your application. Altematively,
l! simply choose the one that best describes its type.
Adjust RGE
i
Color White Paint
— )
g Display Gamma
b w
Options Calibration
| smartimage =
J . Game
Help
Internet Standard

14

Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat déng khi chon
Preferences (Ju tién) tr menu Options
(Tuy chon) sé xuéng. Trén man hinh
khéng hé trg twong thich véi chudn DDC/
Cl, chi c6 sén céac thé Help (Tro giup) va
Options (Tuy chon).

" W SmartControl 2 - Phiips 22581 (C530715000001) | 2)\ X

SmartControl Lite PHILIPS

Preferences

You can use the folowing options to configure
SmartContral.
¥ Enable menu when right-clicking on desktop

¥ Enable task tray menu
¥ Run at system start-up
Set Transparency:

€ 0% ¢ 50% ¢ 100%

Pre!eren ces
udio

Adjust A

L.
2

Auf

=3

ot

E‘
3
=4

-

iwm §
il

Options

=
=3
=
&

Help

« Hién thj cac cai dat wu tién hién hanh.
« O vira chon sé bat tinh ndng nay. O
chon 1a nat bat/tat.

* Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai sén)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (P34 tat)
sé x6a SmartControl Lite khéi menu
thudc tinh click phai.

« Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thj cac tuy chon menu
cho Help (Tr¢ giup), Technical Support
(Hd tro ky thuat), Check for Update
(Kiém tra cap nhat), About (Vé) va Exit
(Thoat). Khi da tat Enable task tray



Options>Audio (Tuy chon>Am thanh)
- Sé& chi hoat ddng khi chon Audio (Am
thanh) tir menu Options (Tuy chon) sb
xudng.

menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thj EXIT
(THOAT).

» Theo mac dinh Run at Startup (Chay
khi kh&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé& khéng
bat khi kh&i déng hodc nam trong
khay tac vu. Cach duy nhat dé bat
SmartControl Lite |a to phim tat trén
man hinh nén hoéc tir file chwong
trinh. B4t ky b6 cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khong tai khi 6 nay khéng dwoc chon
(Da tit). \Q 9

Trén man hinh khéng hd tre twong thich
v&i chudn DDC/CI, chi cé san cac thé
Help (Trg giup) va Options (Tuy chon).

PHILIPS

B smartControl
SmartControl Lite

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Turn off the integrated loudspeakers by checking the
Mute checkbox.

I Mute

* Enable transparency mode (Bat ché \5 .
do trong suot) (Windows 7, Vista, XP). o -
Mac dinh 1a 0% Mo. BT P

Options>Input (Tuy chon>Nhap) - Sé \% B

chi hoat déng khi chon Input (Nhap) tt -

menu Options (TUy chon) s6 xudng. Trén \

man hinh khéng ho tro twong thich voi b P @
chuan DDC/CI, chi c6 sn cac thé Help

(Tro giup) va Options (Tuy chon). Tat ca
céac thé SmartControl Lite khac déu khéng
cb san.

Help>User Manual (Tro gitp>S6 tay str
dung) - Sé chi hoat ddng khi chon User
Manual (Sé tay st dung) tr menu Help
(Tro gitip) 6 xubng. Trén man hinh khéng
hé tro twong thich véi chuan DDC/CI, chi
cb san cac thé Help (Tro giup) va Options
(Tay chon).

2 - Philps 22581 (€530715000001) £%}(X

PHILIPS

1 SmartControl
SmartControl Lite

Input

Your display has two inputs (connections on back of
this disphy) so you can hook up two different sources
at the sa he Analog In and Digital In
buttons source you'd like to view. You
are currently viewing the analog in image.

2 - Philips 225B1 (C530715000001) | )X

PHILIPS

IMPORTANT! ou switch inputs SmartControl may
lose the abiity to control your monitor. In this case you
may have to use the Input Select button on the front
of your monttor to switch back to the original input
before SmartControl functionality can be restored.

|
\S Q B SmartControl
Adjust Audio

SmartControl Lite

L
Auto Piot
H User Manual
If you need help setting up or operating SmartContral,
Color Input click the Tech. Support button. You'll have the
. . N option to fil out an Assistance Form.
E A You can also choose to have information about your
Wizard | software automatically attached to the assistance
6 | form. You'll need to be oniine to use this feature.
Options p;ts Adjust
.\ w User Manual
Multi Monicors /.
cd
s Update
Help — @
s
4 DIS;hV D
&
Analog In Digital In \ <
System ID
2 ~ Options
H « R h . . d A h , d = S X5
. ién thi giao dién huwdng dan Source g
(Ngudn) va cai dat nguén nhap théng
. ‘a N =
tin hién hanh. =3
° User Manual Tech. Support

Trén cac man hinh nhap riéng, giao
dién nay sé& khong hién thi.

15



Help>Version (Tro’ giup>Phién ban) - Sé
chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sb xubng.
Trén man hinh khéng hé trg twong thich
v&i chuan DDC/CI, chi cé san cac thé
Help (Trg giup) va Options (Tuy chon).

B SmartControl 2 - philps 22581 (Cs30715000001) £¥} %

SmartControl Lite PHILIPS

Version

SmartControl
Version 0.00 EVALUATION dtune-plp-R2009-12-17-
1913-04

DDC/CT Communication: Yes - ATI2 API

Copyright ® 1993-2009 Portrait Displays, Inc.

Adjust ﬂ

Menu nhay cam véi thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thudc tinh) sé& dwoc Bat. Néu
da chon Enable Context Menu (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

g SmartControl
Select Preset 4
Tune Display

gt S
el ge

Menu thudc tinh ¢6 bén muc nhap:

* SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé hién thj.

+ Select Preset (Chon cai dat san) -
Cung cAp menu cac muc cai san da
lwu theo trinh tw dé st dung ngay.
Déu kiém sé hién thi muc cai san hién
da chon. Muc Factory Preset (Cai sén
gbc) cling c6 thé dwoc chon tir menu
s6 xudng.

16

Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.
Smartlmage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

ba bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite tir khay tac vu. Click trai
Sé bat rng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

Help (Tro giup) - Truy cap file User
Manual (Sé tay st dung): Mé& file User
Manual (S6 tay st dung) qua cira sb
trinh duyét mac dinh.

Technical Support (H6 tro ky thuat) -
hién thi trang hd tro k§ thuat.

Check for Update (Kiém tra cap nhat)
- d&n ngwdi dung dén Nén (rng dung
PDI va kiém tra phién ban cta nguoi
dung so v&i phién ban cé sdn maoi
nhét.

About (V&) - Hién thj théng tin tham
khao chi tiét: phién ban san pham,
théng tin vé phién ban va tén san
pham.

Exit (Thoat) - Bong SmartControl Lite.



DPé chay lai SmartControl Lite, hay chon
SmartControl Lite ttr menu Program
(Chwong trinh), click d6i biéu twong PC
trén man hinh nén hoéac kh&i dong lai hé
thdng.

PHILIPS

SmartCon

SmartControl
“ersion 3.20
chune-standard-R2007-01-04-1151-23
Copryright 1883-2007 Portrait Displays, Inc.
Patents Pending

Da tat menu khay tac vu

Khi da tat Khay tac vu trong thuw muc

wu tién, chi con co6 san lwa chon EXIT
(THOAT). Bé x6a hoan toan SmartControl
Lite khéi khay tac vu, hay tat Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).
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4. PowerSensor™

(Chi ap dung cho mau 227E3LPH)

PowerSensor 1a cdng nghé doc dao than thién véi méi truéng tov Philips vén cho phép
ngwdi dung tiét kiém dén 80% lwong dién tiéu thu. Cung véi 6 dia Sense va Simplicity cia
Philips, cdng nghé dé sir dung nay hoat ddng ngay khi ban bat hé théng ma khéng can cai
d&t bat civ phan cirng hay phdn mém nao va ciing khéng can sy can thiép ctia ngudi dung
& ché dé mac dinh.

Hl cach hoat dong? - ‘

* PowerSensor hoat ddng theo nguyén tac truyén va nhan cac tin hiéu “hdng ngoai” vo
hai dé phat hién sy hién dién cia ngudi dung.

* Khi ngudi dung hién dién & phia trwéc man hinh, man hinh sé hoat déng binh thwdng
theo cac cai dat ma nguwoi dung da thiét [ap sén, chang han nhuv d6 sang, do twong
phan, mau sac, v.v...

* Gia st man hinh da dwoc cai @ mirc 100% do sang chang han, khi nguoi dung roi
khéi chd ngodi va khdng con hién dién & phia trwdc man hinh nika, man hinh sé tw
doéng giam mdrc tiéu thu dién xudng con 80%.

Nguwoi dung cé mat & phia trwéc Nguw&i dung khéng c6 mat

Mrc tiéu thu ngudn dién nhw minh hoa & trén chi dé tham khao
Bl cai dat

Cai dat mac dinh
Theo cai dat méc dinh (Cai dat 3), PowerSensor duworc thiét ké dé nhan ra sy hién dién
cla nguw¢i dung & khoang cach 90-110 cm (35,4-43,3 inch) tinh tlr phia man hinh va trong
pham vi 5 d6 & bén trai hoac phai man hinh.

Cai dat tuy chinh

* Neéu ban muédn & trong mét vi tri bén ngoai cac khu Ve liét ké & trén, hay chon muirc
cwong do tin hiéu cao hon dé dat hiéu qua phat hién t6i wu: Cai dat cang cao, tin hiéu
phat hién cang manh. Jcj)é t0i da hdéa hiéu qua hoat déng ctia PowerSensor va giup phat
hién chinh xac, hay ngoi ngay trweédc man hinh cta ban.

« Néu ban chpn mot vi tri xa hon mér] hinh 110 cm hoac 43,3 inch, hay cai muc tin hiéu
phat hién t6i da cho khoang cach dén 130 cm hoac 51,2 inch. (Cai dat 4)

« Vi mot sb loai vai mau tdi thworng cd xu hwéng hép thu tin hiéu hdng ngoai ngay ca khi
ngwdi dung hién dién trong pham vi 100 cm hoac 40 inch tinh tir man hinh, hay tang
muc cwdng do tin hiéu khi ban mac dé den hoac quan ao mau t6i khac.

« Ban c6 thé tr& vé ché dd méac dinh bét c Iic nao (Cai dat 3).

18



4. Cam bién nguodn
Phim néng Khoang cach cadm bién

= +3

@/v /A SENSOR/ /0K [0)

El Cach chinh cai dit

Néu PowerSensor khdng hoat déng chinh xac trong hodc ngoai pham vi méic dinh,
day la cach tinh chinh tin hiéu phat hién:

« Nhéan phim néng PowerSensor.

* Bansétim théy vi tri mac dinh “3” trén thanh tuy chinh.

«  Chinh mirc phat hién PowerSensor sang Cai dat 4 va nhan OK.

«  Thir cai dat méi d& xem PowerSensor c6 phat hién ban chinh xac & vij tri hién tai hay
khéng.

& Ghicha

Ché dd PowerSensor dugc chon thi céng sé& van gilr nguyén hoat dong trr khi va cho dén
khi né dwoc chinh lai hodc phuc hdi vé ché dd méac dinh. Néu ban nhan thdy PowerSensor
qua nhay cam v&i nhivng clr ddng qua gan vi mét ly do nao doé, hay chinh vé mdrc cuwong
do tin hiéu thap hon.
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5. Cac théng so ky thuat

Loai mat man hinh TFT-LCD

DPén nén LED

C®& man hinh 21,5" W (54,6¢cm)
Hé sb co 16:9

D6 pixel 0,248 x 0,248 mm
Do sang 250 cd/m?

Do twong phan théng minh | 20,000,000:1

D6 twong phan (chuén) 1000:1

Thoi gian dap (rng (chuan) | 5ms

Do phan giai téi wu

1920 x 1080 @ 60Hz

Goc xem

170° (H) / 160° (V) @ C/R > 10

Cai tién hinh anh

Smartlmage Lite

Mau man hinh

16,7 triéu mau

Dau vao tin hiéu

Téc d6 phat doc 56Hz - 76Hz
Tan sb ngang 30kHz - 83kHz
sRGB (P&-Luc-Lam chuan) | CO

DVI (KTS), VGA (Analog),
HDMI (chi 4p dung cho mau 227E3LH, 227E3LPH)

Tin hiéu vao

Tién ich cho nguwoi dung

DPdng bd riéng, Bdng bd véi tin hiéu xanh luc

227E3L: E/v ©/A /4 2/0K d
227E3LH: @/v ©/A 1]/ < 2/0K 0]
227E3LPH: @&/v ©/A SENSOR/ /0K Q)

Ng6én ngr OSD (Hién thi
trén man hinh)

Tiéng Anh, Tiéng Phap, Tiéng Ptrc, Tiéng Tay Ban Nha, Tiéng Y,
Tiéng Nga, Tiéng Hoa gian thé, Tiéng Bd Dao Nha, Tiéng Thd Nhi Ky

Tién ich khac

Khoa Kensington

Twong thich v&i chuan Plug
& Play (C&m vao I3 phat)

Nghiéng

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

Ché d6 bat

227E3L: 21,8W(chuan)
227E3LH:  21,8W(chuan), 27W(tbi da)
227E3LPH: 21,8W(chuan), 24W(t6i da)

Tiét kiém nang luong Dién ap dau vao Dién &p dau vao Dién &p dau vao

(Phuo’-ng ohap thie nghiém AC voicong suat | AC véicong suat | AC vai cong suat

ST 6 6 i 100VAC +/-5VAC, | 1M15VAC +/-5VAC, | 230VAC +/-5VAC,
' 50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Hoatxdong théng thwdng 18,4W 18,4W 18,5W

(chuan)

Ngu 0,5W 0,5W 0,5W




Tat

0,5W

0,5W

0,5W

Dién &p dau vao
AC véi cong suat

Dién ap dau vao
AC véi cong suat

Dién ap dau vao
AC véi cong suat

LI s 100VAC +/-5VAC, | 115VAC +/-5VAC, | 230VAC +/-5VAC,

50Hz +/- 3Hz B60Hz +/- 3Hz 50Hz +/- 3Hz
Hoat déng théng thudng 62,8 BTU/qgi& 62,8 BTU/gi® 63,14 BTU/gi
Ngu 1,71 BTU/gio 1,71 BTU/gio 1,71 BTU/gio
Tét 1,71 BTU/gio 1,71 BTU/gio 1,71 BTU/gio
DPén bao LED ngudn Ché d6 bat: Ché do Trang, Ch&/Ngu: Trang (nhap nhay)
B& ngudn Thir néng, 100-240VAC, 50/60Hz

San pham kém theo dé giwr
(Réng x cao x day)

534,34 x 407,9 x 216 mm

San pham khéng kém theo
dé gitr (R6ng x cao x day)

534,34 x 335,89 x 41,1 mm

Sa&n pham kém theo dé gitv | 4,01kg
S?n .eham khéng kem theo 3,47kg
dé gitr

San pham déng goi 4,17kg

Pham vi nhiét d6 (hoat déng)

0°C-40°C

Gi&i han nhiét do
(Khéng hoat déng)

-20°C -60°C

Do &m twong dbi

20% - 80%

Po cao

Hoat dong: + 365.760,00cm (3.658m)
Khéng hoat déng: + 1.219.200,00cm (12.192m)

MTBF (Thoi lwgng trung
binh gitra cac sw cb)

30.000 gioy

Chi thi ROHS (Gidi han cac
chat gay hai)

coO

EPEAT

D4u Bac (www.epeat.net)

Thung dwng
Phé chuan theo quy dinh

Mau

Co6 thé tai ché 100%

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified,
UL/cUL, BSMI, 1SO09241-307

|

Den (Phia sau), Xanh (Phia trwéc)

L&p son ngoai

Bong loang

& Ghi chu

1. Dau Vang hay Dau Bac EPEAT chi c6 hiéu Iwc tai noi ma Philips da déng ky san pham. Hay truy
cap www.epeat.net dé biét tinh trang dang ky tai quoc gia cua ban.

N

tai vé phién ban td roi maéi nhét.
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5.1 Chée dé doé phan giai & cai
dat san

re
A=

E! D6 phan giai téi da
1920 x 1080 @ 60 Hz (d4u vao
analog)
1920 x 1080 @ 60 Hz (d4u vao KTS)
E1 Do phan giai khuyén dung
1920 x 1080 @ 60 Hz (d4u vao KTS)

480i | 720x480 | SD (60

480p | 720x480 | SD (60

576i | 720x 576 | SD |50

576p | 720x 576 | SD |50

720p | 1280 x 720 | HD |50, 60

1080i {1920 x 1080 | HD |50, 60
1080p | 1920 x 1080 | HD |24, 25, 30, 50, 60

& Ghi chi

Lwuy réng man hinh cliia ban hoat déng
tét nhat & do phan giai gbc 1920 X 1080
@ 60Hz. D& c6 chat lwong hién thj tét
nhat, hay dung dé phan giai khuyén nghi
nay.
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6. Quan ly nguon dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh ¢6 thé tw dong giam
tiéu thu dién khi khéng st dung. Néu phat
hién nhap tr ban phim, chudt hay thiét bj
nhap khac, man hinh sé “hoat dong” ty
dong. Bang sau day sé hién thi mie tiéu
thu dién va cach truyén tin hiéu cta tinh
nang tiét kiém dién tw dong nay:

Chédd |\/400 ngg Pbdng | Ngudn dién st | Mau dén

VESA * |bo doc dung LED
ngang
N = ; ; <21,8 W 2

Hoat dong| BAT Co Co (chuan) Trang
) Tréng
Ngu TAT |Khéng|Khéng| <0,5 W (chuan) | (Nhép
nhay)
Tét TAT | - - |<0,5W (chudn)| TAT

Cai dat sau day dwoc dung dé do mirc

tiéu thu dién trén man hinh.

« Do phan giai gbc: 1920 x 1080

* D6 twong phan: 50%

* Do sang: 250 nit

« Nhiét d6 mau: 6500k v&i kiu mau
trdng day da

& Ghi chu

D@ lieu nay chiu sw thay ddi ma khong
can théng bao trudéc.
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7. Thong tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!
This display is designed for both you and the

planet
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the
TCO Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.
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* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of
the TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is
now requested by users and |T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver: 2.1

I[n Technology for you and the planet
CERTIFIED




EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

«  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

e EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

» EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

«  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

*  2006/95/EC (Low Voltage Directive).

« 2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

+ 1S0O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

« (S EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

« TCO CERTIFED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

e Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant |'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic
Only)

Thiz device belongs to category B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A devics on the spacification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 matars). The ussr of the
device is obliged to take all staps necessary to remove sources of intarfarence io tals-
communication or ofher devices.

Pokud neni na typowam &tithu poditade
spadd aviomaticky do tfidy B podle EN 55022, Pro zafizen| zefazend do tfidy A (chranné
pésmo 30m) podie EM 55022 platl nésledujicl. Dojde-1i k rufanl telekomunikatnich nebo
Pnych zafizeni je ufvatel povinnen provést takovd opatfgni, aby meSani odstranil.

uvedano, #a spads do do ffidy A podis EN 55022,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Uregdzende powinno byé zasilane x priaads 2 preybgezsonym obwodem ochronmym (gniazdo
kotkiensy. Wapdlpracuggce ze soby uresdeenta (kommputer, monstor, drubrka) powiany byd sasilane
# Lo shmepn drddla.

Instalacja elektrycma pomicsacsenia powinna mwierad w preewaodce Browym reserawows achrong
proed rwarciami, w postaci beepiecenika o wartedcl smamionowe] mie wigkszej ni 16A (amperiw).
Wooalu catkowitign wybpernenis uregdeents 2 siect zasilania, naledy wyinl wiveeky kabla
easilajeego = griazdka, kodre powinno anajdowad sig w poblizu ursdeenda @ bvd Barws dostgpie.

Anak berpieeeefarwa "B” potwiendza zpodaodd urssdrena @ wymapandami beepleceefsiwa
whytkowanma zawartyml w FR-SLTAI107 1 PN-REAGZE].

Pozostale instrukcje begpieczensiwa

* Mie maledy whywad wiyceek adapierowvch lub wuwad kedka obwedw ochrommego = wiyceki.
Jedel komsoiene jesl iky e prasdluiaczs o naledy whyd praodlusacs 3-rvlowega 2
prrawidlowa potscronymm praewoden ochmonnymn.

Sysbem kompulerowy maleiy saberpiccryd proed naghyme, chowilowymi wenostama fub spad-
kami napgcia, uiyw limimatars prespeed, uresdzenio dopasowajicego luh
berakiocemowega zaslania

* Maledy upewnil sig. ab

i i Lekalo ng kablech sysiemu komputerowego. araz aby kabde ne
byly witletaczone w it

g, gdese mmodkna byloby na mie nadepliwal lub potyked sig o me.

* Mie maledy roclewad napogio an meych plyndo e system kompuierowy.

*  Nie nalery wpychal Fadnyeh preedmictow do abwoendw systemmu kemputervwega, givi moie
1o spowodowad pedar lub poradenie prydem, popree: rwarcie chemenida wenngtrznych

* System kompaterowy powinden enapdowad sig 2 dala od greejnikiw o drédel clepla. Poradro,
mie maleey blokawad atworaw wentylacyjnych. Mabeidy unzkac kladeenza luinych papserdw posd
kamputer oz umiesrczania kampubera w clasaym migjscw bes madliwasc cyrkulacji powi-
elrra wokal nicge.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
MElHEMERIITE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Réntgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
'@ 5 Abs. 4 der Rontgenverordnung erfullt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdagt 7/0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



7. Thong tin quy dinh
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

S EABERHS

REPEAN (RFESSREREGATENE) (BFRAPEXRROHS) -
IFRSFIH T AR S S NE SRR T ANERME B

FRBERZ
B (F&HECRT)

BEEEYRSETE
B EFR BEEENRNTE
i * i Favils ] BREE ER_EE
(Pb) (Ha) | (Cd) | (CrE+) (PER) (PBDE)
sheE o @) @) [e) [@) [e]
CRTERER X O o o o] O
BREREATE X @] o] o [o] [e]
AR A X o] @] O o] o]
ERIER# X o] @] O o] o]
RA S X [e) [e] [s] @] (o]
* ' BRI RISED RIS SRR MR R - MR R AR SRBS
O FREHEEE BN AT SR & B
{RFEATGTAEEENRARBERME) WEAERER T
X RTEAEA BN R E ORI RS R S Y
(A TFEEFRFAEAEIRNRRERGE) NENERER  BRERFIT "X B4
FEMBERHSEMER (BT E s )
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8. Dich vu cham séc
khach hang va bao
hanh

8.1 Chinh sach 16i diém anh
man hinh phang cua Philips

Philips c6 gang cung cép cac san pham
chat lwgng cao nhat. Chung téi ap dung
mot sb quy trinh san xuét tién tién nhéat
trong Iinh vic va thye hién quy trinh kiém
tra chat lwong nghiém ngat. Tuy nhién,
céac 16i diém anh hay diém anh con trén
man hinh TFT dung trong cac man hinh
phang d6i khi khdng thé tranh khoi. Khong
nha san xuét nao c6 thé dam bao réng
moi man hinh sé khéng co cac 16i diém
anh, nhwng Philips dam bao rang bat ky
man hinh nao c6 mét sé 16i khong thé
chp nhan sé duwoc stra chiva hoac thay
m&i dwa vao chinh sach bao hanh. Thong
bao nay giai thich nhirng kiéu 16i diém anh
khac nhau va dinh nghia cac mirc 16i cd
thé chap nhan cho méi kiéu 16i. D& hwéng
dich vu stra chiva hay thay thé theo chinh
sach bao hanh, s6 lwong 16i diém anh trén
man hinh TFT phai vuot qua cac mic
chap nhan nay. Vi du, khéng qua 0,0004%
diém anh con trén man hinh cé thé bij I5i.
Ngoai ra, Philips tham con dat ra cac tiéu
chuan chét lwong cao hon cho mét sb
kiéu hay két hop 16i diém anh vén dé nhin
thdy hon céac kiéu 16i khac. Chinh sach
nay c6 hiéu lwc trén toan cau.

-~ ™

Pidm anh con Diém anh con  Biém anh con

¢

Piém anh va diém anh con

Diém anh hay phan t& anh goém ba diém
anh con trong cac mau chinh dé, luc va
lam. Nhiéu diém anh cung tao thanh hinh
anh. Khi moi diém anh con ctia mot diém
anh sang lén, ba diém anh con c6 mau
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sac cung hién thi nhuw mét diém anh trdng
don Ié. Khi moi diém anh con t6i me, ba
diém &nh con c6 mau s&c cung hién thi
nhw mét diém anh den don 18. Nhirng két
hop diém anh con sang va téi khac hién
thi nhw cac diém anh don 1& tir nhirng
mau khac.

Cac kiéu 16i diém anh

Cac 16i diém anh va diém anh con hién

thi trén man hinh theo nhirng cach khac
nhau. C6 hai kiéu 16i diém anh va nhiéu 16i
diém anh con trong méi kiéu 6i.

Céc 16i chdm sang

Céac 16i chdm sang hién thj dwéi dang cac
diém &nh hay diém anh con vén luén sang
hay “bat”. Nghia la mdi chAm sang la mot
diém &nh con vén ndi lén trén man hinh
khi man hinh hién thj kiéu hinh t6i me. Co
céac kiéu 16i chdm sang.

G

Mot diém anh con sang dd, luc hay lam.

I C

Hai diém &nh con sang gan nhau:

- Dbé+Lam=Tim

- D6 + Luc =Vang

- Luc + Lam = Luc lam (Lam nhat)

-




Ba diém anh con sang gan nhau (mot
diém anh trang).

& Ghi cha

Chém sang dd hay lam phai sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so v&i
cac chdm xung quanh.

Cac 16i cham den

Céac 16i chAm den hién thi dwéi dang cac
diém anh hay diém anh con vén luén téi
mo hay “tat”. Nghta la méi cham tdi mo
la mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 cac kiéu 16i chadm den.

N J

4 N

D6 gan cua cac 16i diém anh

Vi céc 16i diém anh va diém anh con cua
cung kiéu 16i von gan v&i mot kiéu 16i khac
co thé dé nhin thay hon, Philips cling néu
ré cac dung sai vé dé gan cuia I6i diem anh.

4 N

- /

Dung sai 16i diém anh

Dbé hwéng dich vu stra chiva hay thay

thé do céac 16i diém anh trong thoi han

bao hanh, man hinh TFT trong man hinh
phéng Philips phai c6 cac 16i diém anh hay
diém anh con vwot qua nhivng dung sai
néu trong cac bang sau.

LOI CHAM SANG MUPC CHAP NHAN

1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mét diém anh tréng) 0
Khoang céach gitra hai 16i chdm sang* >15mm
Tbng sb 16i chAm sang clia moi kiéu |6i 3

LOI CHAM BEN MUC CHAP NHAN

1 diém anh con t6i mo 5 hoéc it hon
2 diém anh con t6i m& gan nhau 2 hoac it hon
3 diém anh con tbi m& gan nhau 0
Khoang cach gitra hai 16i chAm den* >15mm
Tbng sb 16i chAm den ctia moi kiéu 16i 5 hodc it hon

TONG SO LOI CHAM

MUPC CHAP NHAN

Tbng sb 16i chAm sang hay den clia moi kiéu |6

5 hoac it hon

& Ghichu

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chdm

2. Man hinh nay tuan tha chuan 1S09241-307. (IS09241-307: Yéu cau, phan tich vé hiéu
nang va cac phuwong phap kiém tra tuan thi cho man hinh dién t)
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8.2 Cham séc khach hang & Ché dé bao hanh

Dé cé théng tin chi tiét vé chinh sach bao hanh va yéu cau hd tro thém dwoc ap dung cho
khu vire cta ban, vui long truy cap website www.philips.com/support. B,an cling co thé lién
hé v&i Trung tdm cham séc khach hang dia phwong cta Philips theo so dién thoai dudi
day.

Théng tin lién lac cho khu vwec TAY AU:
Quéc gia ASC (Trung tam

S6 cham séc khach

dich vu Gy quyén) hang

Germany Siemens 1&S +49 01803 386 853 €0.09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Théng tin lién lac cho khu viec TRUNG VA PONG AU:

Quéc gia Trungtam  ASC (Trung tam dichvu g4 }xn, <66 khach hang
dich vu uy quyen)
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
Serbia & ) Kim Tec d.0.0. +381 11 20 70 684
Montenegro
Slovenia NA PC H.and +386 1 530 08 24
_ NA Comel +380 562320045
Ukraine :
NA Topaz-Service Company | +38 044 245 73 31
Russi NA CPS +7 (495) 645 6746 (for repair)
ussia
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. |NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary : :
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:
Trung tam dich vu

Qubc gia

Brazil

Argentina

Vermont

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Québc

Sb cham so6c khach hang: 4008 800 008

Théng tin lién lac cho khu viec NAM MY:

Quéc gia Trung tam AAGHIEIENENCEN), S6 cham séc khach hang

dich vu ay quyén)
U.S.A. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Théng tin lién lac cho khu virc Chau A TBD/Trung Dong/Chau Phi (APMEA):

Quéc gia

Trung tam

dich vu

ASC (Trung tam dich vu
uy quyeéen)

S6 cham séc khach hang

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Smart Pixels Technology Hong Kong:Tel: +852 2619 9639
Macau Ltd. Macau:Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIALTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika | Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea |NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics
Singapore NA Singapore Pte Ltd (Philips | (65) 6882 3999
Consumer Care Center)
PCCW
Taiwan Teleservices |FETEC.CO 0800-231-099
Taiwan
Thailand ~ |NA ﬁ’;‘s Computer System Co., | g69) 034-5408
South Africa | NA Syvara feshnologies Pty g6 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates L.L.C
Israel NA Eastronics LTD 1-800-567000
: , +84 8 38248007 Ho Chi Minh City
Vietnam NA Ez-r;saer:wclzj dlnformatlc +84 5113.562666 Danang City
pany tid. +84 5113.562666 Can tho Province
I : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d@stributor and/or service
provider currently
Distributor: Computer
880-2-9141747, 9127592
Bangladesh |NA glj)tl;rce Ltd (warranty buy- 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992

(warranty buy-out)
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9. Khac phuc sw co &
Hoi DPap

9.1 Khac phuc sw co

Trang nay gidi quyét cac sy cb vdn nguoi
dung c6 thé khac phuc. Néu sy ¢b van
tiép dién sau khi ban da th» dung céac giai
phap trén trang nay, hay lién hé voi dai
dién dich vu khach hang cta Philips.

Bl Ccac sw co thwong gap

Khéng cé hinh anh (Pén LED nguén

khong sang)

E)am bdo da cdm day ngudn vao 6
cam dién va mat sau cdia man hinh.

«  Trwdec tién, ddm bao nut nguén &
mét tredc man hinh nam & vi tri OFF
(TAT), sau d6 day nut sang vi tri ON
(BAT).

Khéng cé hinh anh (Pén LED nguén

sang trang)

*  Dam bao da bat may tinh.

«  Pam bao cap tin hiéu da dwoc két nbi
dung cach v&i may tinh clta ban.

. Dém béo cap man hinh khong co6 cac
ch,éu cam bi cong trén mat két noi.
Néu co, hay stra hay thay méi cap.

« Co thé da bat tinh nang Tiét kiém
nang luvong

Man hinh théng bao

Attention

Check cable connection

« Pam bao cap man hinh da duoc két
ndi dung cach vé&i may tinh cua ban.
(Ciing tham khao Hwdng dan khéi
ddéng nhanh).

+ Kiém tra xem cap man hinh c6 cac
chau cdm bi cong hay khéng.

*  Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khéng hoat déng
Chwrc ndng tw ddng chi ap dung & ché
dd VGA- Analog. Néu khong hai long
véi két qua, ban co6 thé thuc hién cac
diéu chinh tha céng qua menu OSD
(hién thj trén man hinh).

& Ghicha
Chtrc nang Auto (Tw déng) khong ap dung
& ché dd DVI-KTS vi n6 khéng can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay ] ]

* Khong thwe hién bat ky buwéc khac
phuc sw cb nao

« Ngat ngay két ndi man hinh khoi 6
cam dién chinh cho an toan

* Lién hé ngay v&i dai dién dich vu
khach hang cua Philips.

Bl Cac sw cd hinh anh

Hinh anh khéng nam giira tam man

hinh

» Chinh vij tri hinh anh qua chirc nang
“Auto (Tw ddng)” trong cac nut diéu
khién chinh trén menu OSD.

« Chinh vi tri hinh anh qua Phase/Clock
(Goc pha/Bdng ho) cliia Setup (Cai
dat) trong cac nut diéu khién chinh
trén menu OSD. N6 chi ¢6 hiéu lwc &
ché do VGA.

Hinh anh rung Ién trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cém chat dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thj hién twong chap chén doc

« Chinh hinh anh qua chic nang “Auto
(Tw déng)” trong cac nut dieu khién
chinh cia menu OSD.



* Loai bd cac vach doc qua Phase/
Clock (Goc pha/Bdng hd) ciia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi c6 hiéu
lwc & ché d6 VGA.

Hién thj hién twong chap chon ngang

L

* Chinh hinh anh qua chirc nang “Auto
(Tw ddng)” trong cac nuat diéu khién
chinh cia menu OSD.

* Loai bd cac vach doc qua Phase/
Clock (Géc pha/Béng hd) cla Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi c6 hiéu
lwec & ché d6 VGA.

Hinh anh hién thi nhoe, khéng ré hoic

qua mo

* Chinh d6 twong phan va do sang trén
menu Hién thj trén man hinh (OSD).

Hién twong “anh ao”, “anh thir néng”
hay “anh béng ma” van hién thj sau khi
da tat nguon.

« Hién thj lién tuc cac anh tinh trong mét
thoi gian dai co thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thtr néng”, “Anh a0”
hay “Anh bong ma” 13 hién twong phd
bién trong céng nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh th&r ndng” hoac “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau mot thdi gian man hinh bj
ngat dién.

e Luobn bat trinh bao vé man hinh
chuyén ddng khi ban khéng st dung
man hinh.

* Lubn bat &ng dung lam m¢&i man hinh
dinh ky, néu khéng, man hinh LCD
cta ban sé hién thi nhirng ndi dung
tinh khéng thay dbi.
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« Cac hién twgng “anh thtr néng” hay
“anh ao” hay “anh béng ma” sé khéng
biét mét va ban can mang man hinh
di stra. Thiét hai nhw trén khéng nam
trong chinh sach bao hanh cua ching
toi.

Hinh hién thj bién dang. Van ban bi m&

hoac nhoe.

« Cai dd phan giai man hinh may tinh
sang cung ché do voi dd phan giai
man hinh gbc khuyé&n dung cdia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thi trén man hinh

« Cac chdm con lai 1a dac tinh théng
thwéng clia man hinh tinh thé 16ng
dung trong cdng nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém théng tin.

DPén “bat nguon” qua sang va gay choéi

mat

« Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED nguén trong cac nut
diéu khién chinh cla menu OSD.

DPé duwoc tro gitp thém, hay xem danh
sach Trung tdm théng tin khach hang
va lién hé v&i dai dién dich vu cham sbc
khach hang cua Philips.



9.2 Héi dap SmartControl Lite

H1.

Dap:

H2.

Dap:

H3.

Dap:

T6i da déi man hinh trén PC sang
man hinh khac va khéng thé s
dung SmartControl, téi can lam gi?
Hay kh&i dong lai PC va kiém tra
xem SmartControl Lite c6 hoat déng
khéng. Néu khéng, ban can phai g&
bd va cai dat lai SmartControl Lite dé
dam bao cai dat driver thich hop.
Cac chitrc nang SmartControl Lite
da hoat dong tét trwéc d6, nhwng
gi®» né khong hoat déng nira, toi
c6 thé lam gi?

Néu da thwc hién cac thao tac sau,
thi ban can phai cai dat lai driver
man hinh.

D3 dbi bo thich rng dé hoa video
sang mot adapter khac

Da cap nhat driver video

Cac hoat déng trén HDH nhuw goi
hoac loat (rng dung

Chay Cap nhat Windows va cap
nhat man hinh va/hoac driver video
Ba khéi dong Windows bang nut tat
hay ngat két noi man hinh.

DPé xac dinh sw ¢, hay click chudt
phai My Computer (May tinh cla t6i)
va click vao Properties (Thudc tinh)-
>Hardware (Phan ctng)-> Device
Manager (Quan ly thiet bi).

Néu nhin thay “Plug and Play
Monitor” (Man hinh cdm vao 1a chay)
hién thi trong Monitor (Man hinh), thi
ban can cai dat lai. Chi can g& bod
SmartControl Lite va cai dat lai.

Sau khi cai dat SmartControl Lite,
khi click vao thé SmartControl
Lite, khdng c6 muc nao bat Ién
sau mét lat hodc théng bao 16i
hién thi, diéu gi da xay ra?

C6 thé 1a do bd thich ing d6 hoa cua
ban khéng twong thich voi i'ng dung
SmartControl Lite. Néu bé thich trng
dd hoa la mét trong sb cac nguyén
nhan néu trén, thlr tai vé driver
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H4.

Dap:

H5.

DPap:

bd thich rng d& hoa méi nhat tw
website cua cac cong ty twong ng.
Cai dat driver. Go bé SmartControl
Lite va cai dat lai mét 1an niva.

Néu né van khéng hoat déng, thi

rat tiéc la bd twong rng dd hoa
khéng dwoc hd tro. Vui Idng truy cap
website clia Philips va kiém tra xem
driver SmartControl Lite m&i nhat da
cd san hay chua.

Khi toi click vao Product
Information (Théng tin san pham),
né chi hién thi mét phan, diéu gi
da xay ra?

C6 thé 1a do driver b thich (rng dd
hoa cua ban khéng phai la phién
ban cap nhat mé&i nhat vén hé tro
day da giao dién DDC/CI. Hay tha
tai vé driver bd thich ing d6 hoa
m&i nhéat tlr website clia cac cong
ty twong (rng. Cai dat driver. G bo
SmartControl Lite va cai dat lai mot
lan niva.

Attention

Theft mode enabled

Toi da quén ma PIN cho chirc nang
Theft Deterrence (Chéng trém). Téi
can lam gi?

Trung tdm dich vu Philips c6 quyén
yéu cau xac nhan va quyén hop lé
dé thiét lap quyén s& htru man hinh.
Xin lwu y chirc ndng chéng trom
dwoc cung cap nhw 1a tly chon tién
ich mién phi. Quan ly ma PIN Ia
trach nhiém riéng cua ngudi dung
ca nhan hay td chirc vén d3 tao ra
ma nay. Trong trwd'ng hgp quén ma
PIN, trung tdm dich vu Philips c6 thé
tao lai cho ban v&i mirc phi nhd sau
khi xac nhan quyén s& hiru cda ban.
Xin lwu y chtrc nang nay khéng duwoc
bao gébm trong cac diéu khodn bao
hanh chinh thirc.



9.3 Hoi bap chung
H1: Khi cai cai dat man hinh, téi can
lam gi néu man hinh hién thj
“Cannot display this video mode”
(Khéng thé hién thi ché dé video
nay)?

Dap: D6 phan giai khuyén dung cho man

hinh nay la: 1920 x 1080 @60 Hz.

« Ngat tat ca cac cap roi két néi PC voi
man hinh ma ban da dung truwdc do.

* Trong Windows Start Menu (Menu
khéi dong Windows), chon Settings/
Control Panel (Cai dat/bang diéu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
coO tén “desktop area (vung man hinh
nén)’, chuyén thanh trwot sang murc
1920 x 1080 pixels.

* M@ thé “Advanced Properties” (Thubc
tinh nang cao) va cai Muc céap nhat
(Refresh Rate) sang 60Hz réi click
OK.

» Khé&i dong lai may tinh va lap lai buwéc
2 va 3 dé kiém tra xem PC cla ban da
dwoc cai sang mire 1920 x 1080 @60
Hz hay chwa.

« Tat may tinh, ngét két ndi man hinh
cl va két ndi lai man hinh LCD Philips
cla ban.

«  T&t man hinh rdi bat lai PC.

H2: Murc cap nhat khuyén dung cho
man hinh LCD la bao nhiéu?

Mcrc cap nhat khuyén dung cho man
hinh LCD Ia 60Hz. Néu co6 béat cr
hién twong nhiéu ndo trén man hinh,
ban c6 thé cai dat mirc nay sang
75Hz dé kiém tra xem mdc méi nay
c6 loai bo dwoe hién twong nhiéu
hay khong.

Dap:
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H3: Cac file .inf va .icm trén dia CD
la gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Dap: Day la cac file driver cho man hinh
cla ban. Thuc hién theo cac chi dan
trong so tay str dung dé cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hoac |&p dia driver khi ban
cai dat man hinh 1an dau. Thuc hién
theo cac chi dan dé 14p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat tw dong.

H4:
Dap:

Lam thé nao dé chinh dé phan giai?
Card video/driver dd hoa clia ban

va man hinh sé& ciing quyét dinh

cac dd phan gidi co sin. Ban co thé
chon dd phan giai mong mudn trong
Control Panel (Bang diéu khién)

cua Windows® qua thé “Display
properties” (Thudc tinh man hinh).

H5: Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nut OK rdi chon
“Reset” (Cai dét lai) d& phuc hoi moi
cai dat mac dinh gbc.

Dap:

H6: Man hinh LCD c6 kha ning chéng
tray xwéc?

N6i chung ban khéng nén dé bé mat
man hinh va cham qua murc véi cac
vat khac hay va bao vé né khéi cac
vat dung sac hay cun. Khi cdm man
hinh, dam bao khéng dung strc ép
hay lwc manh I&n phia bé mat man
hinh. Diéu nay c6 thé anh huéng
dén cac diéu kién bao hanh cta ban.

Dap:

T6i nén lau man hinh LCD nhw thé
nao?

Dap: Dé lau théng thwdng, hay st dung
khan sach va mém. Dé lau ky, hay
dung cén isopropyl. Khéng dung
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...

H7:



H8:

Dap:

Toi c6 thé thay déi cai dit mau
sac cho man hinh?

D7 nhién, ban c6 thé thay ddi cai
dat mau sac qua nut diéu khién trén
menu OSD theo cac quy trinh sau,
Nhén “OK” dé hién thi menu OSD
(Hién thij trén man hinh)

Nhén “Down Arrow” (Mi tén
xudng) dé chon tuy chon “Color”
(Mau) rbi nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhw sau.

. Color Temperature (Nhiét d6 mau);

V&i cac cai dat trong pham vi
6500K, man hinh sé hién thi “néng”
voi tin hiéu dé-tréng, trong khi nhiét
d6é 9300K tao ra “tin hiéu mat lam-
trdng”.

sRGB (P&-Luc-Lam chuan); day

|a cai dat chuan dé dam bao trao
déi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

User Define (Tw chon); nguwdi dung
c6 thé tw chon cai dat mau sic wu
tién bang cach chinh mau dd, luc va
lam.

& Ghi cha

Do mau anh sang téa ra tr mét vat dung
trong khi n6 dwoc 1am néng. Sé do nay
dwoc thé hién dwa trén ty 1é tuyét doi, (mtrc
dd Kelvin). Cac mre nhiét do Kevin thap
hon nhw 2004K [a mau dd; cac mirc nhiét
dbé cao hon nhw 9300K |a mau lam. Nhiét
dd trung tinh 14 mau trdng & mirc 6504K.

H9:

Dap:

T6i c6 thé két néi man hinh LCD
vé&i moi PC, may chu hay may
Mac?

Co thé. Tt ca cac man hinh LCD
Philips déu hoan toan twong thich
v&i cac PC, may Mac va may cha
chuan. Ban co6 thé can cé dau néi
cap dé két néi man hinh méi hé
thdng may Mac. Vui I6ng lién hé voi
nhan vién kinh doanh cda Philips dé
biét thém thong tin.
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H10:

Dap:

H11:

Dap:

Man hinh LCD Philips ¢c6 hé tro
chuéan Plug-and-Play (Cam vao la
phat)?

C6, cac man hinh Philips déu hd tro
chuan Plug-and-Play twong thich
v&i Windows 7/Vista/XP/NT, Mac
OSX, Linux

Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

Hién thi lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong “anh thir néng”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cla ban. “Anh thir
nong”, “Anh &o” hay “Anh béng ma”
la hién twong phd bién trong coéng
nghé man hinh LCD. Trong moi
treong hop, hién twong “anh thiy
néng” hay “anh ao” hay “anh béng
ma” sé bién mét dan trong mot thoi
gian sau khi da t&t nguén.

Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st
dung man hinh.

Ludn bat yng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cta ban sé hién thi nhirng noi
dung tinh khéng thay dbi.

?® canh bao

Cac hién twong “anh thir néng” hay “anh
40” hay “anh bong ma” sé khong biét méat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng ndm trong chinh sach
bao hanh cua chung toi.

H12:

Dap:

Tai sao man hinh cua t6i hién thi
van ban sac nét va cac ky tw rang
cwa?

Man hinh LCD cua ban hoat déng
tét nhat & dé phan giai géc 1920 x
1080 @ 60 Hz. D& man hinh hién
thj tét nhéat, vui long sir dung d6
phan giai nay.
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